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Important safety instructions

Some of the following information may not apply to your particular product; however, as with any electronic 
product, precautions should be observed during handling and use.
• Read these instructions. 
• Keep these instructions. 
• Heed all warnings. 
• Follow all instructions. 
• Do not use this apparatus near water. 
• Clean only with dry cloth. 
• Do not install near any heat sources such as radiators, heat registers, stoves, or other apparatus (including 

amplifiers) that produce heat. 
• Only use attachments/accessories specified by the manufacturer. 
• Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been 

damaged in any way, such as power-supply cord or plug is damaged, liquid has been spilled or objects 
have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate 
normally, or has been dropped. 

ADDITIONAL SAFETY INFORMATION

•  Apparatus shall not be exposed to dripping or splashing and no objects filled with liquids, such as vases, 
shall be placed on the apparatus.

•  Do not attempt to disassemble the cabinet. This product does not contain customer serviceable 
components.

• The marking information is located at the bottom of apparatus.

PLEASE READ AND SAVE FOR FUTURE REFERENCE

IMPORTANT SAFETY INSTRUCTIONS



Important battery precautions
• Any battery may present a risk of fire, explosion, or chemical burn if abused. Do not try to charge a 

battery that is not intended to be recharged, do not incinerate, and do not puncture.
• Non-rechargeable batteries, such as alkaline batteries, may leak if left in your product for a long period of 

time. Remove the batteries from the product if you are not going to use it for a month or more.
• If your product uses more than one battery, do not mix types and make sure they are inserted correctly. 

Mixing types or inserting incorrectly may cause them to leak.
• Discard any leaky or deformed battery immediately. They may cause skin burns or other personal injury.
• Please help to protect the environment by recycling or disposing of batteries according to federal, state, 

and local regulations.
WARNING: The battery (battery or batteries or battery pack) shall not be exposed to excessive heat such as 
sunshine, fi re or the like.

Ecology
Help protect the environment - we recommend that you dispose of used batteries by putting them into 
specially designed receptacles. 

Precautions for the unit
• Do not use the unit immediately after transportation from a cold place to a warm place; condensation 

problems may result. 
• Do not store the unit near fire, places with high temperature or in direct sunlight. Exposure to direct 

sunlight or extreme heat (such as inside a parked car) may cause damage or malfunction.
• Do not expose to rain or moisture.
• Clean the unit with a soft cloth or a damp chamois leather. Never use solvents.
• The unit must only be opened by qualified personnel.

Headset safety 
To use a headset safely, please keep the following in mind:
• Do not play your headset at a high volume. Hearing experts advise against continuous extended play.
• If you experience ringing in your ears, turn down the volume or stop using the headset.
• Do not use a headset while driving a motorized vehicle or riding a bike. It may cause a traffic hazard and 

is illegal in many areas.
• Even if your headset is an open-air type designed to let you hear outside sounds, don’t turn up the 

volume so high that can’t hear sounds around you.
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FCC Information

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) 
this device may not cause harmful interference, and (2) this device must accept any interference received, 
including interference that may cause undesired operation. 

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to 
radio communications. 

However, there is no guarantee that interference will not occur in a particular installation. If this equipment 
does cause harmful interference to radio or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the interference by one or more of the 
following measures:
•  Reorient or relocate the receiving antenna.
•  Increase the separation between the equipment and receiver.
•  Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
•  Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications not expressly approved by Audiovox could void the user’s authority to operate the 
equipment.

Manufacturer/Responsible Party 
Audiovox Accessories Corporation 
111 Congressional Blvd., Suite 350 
Carmel, IN 46032 

1-317-810-4880 ( No technical /product support is available via this number. This phone number is for 
regulatory matters only.) 

Visit www.rcaaudiovideo.com for technical support

This Class B digital apparatus complies with 
Canadian ICES-003.
Cet appareil numérique de la classe B est 
conforme à la norme NMB-003 du Canada.

RCA 
TH2202

RCA 
TH2204

RCA 
TH2002

RCA 
TH2202R

RCA 
TH2002RDR

RCA 
TH2004

RCA 
TH2204R

RCA 
TH2002R

RCA 
TH2004R
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End user license agreement

End user license agreement
IMPORTANT: READ CAREFULLY BEFORE DOWNLOADING OR INSTALLING THIS SOFTWARE!

THIS END USER LICENSE AGREEMENT (THIS “EULA”) IS A LEGAL AGREEMENT BETWEEN YOU AND AUDIOVOX CORPORATION AND, AS 
APPLICABLE, ANY AUDIOVOX SUBSIDIARY, AS DEFINED BELOW (COLLECTIVELY “AUDIOVOX”), FOR THE RCA BRANDED PORTABLE 
DIGITAL AUDIO/VIDEO DEVICE APPLICATION/DRIVER SOFTWARE PROGRAM WHICH MAY INCLUDE ASSOCIATED SOFTWARE 
COMPONENTS, SOFTWARE LICENSED BY AUDIOVOX FROM THIRD PARTIES (“LICENSORS”) AND ASSOCIATED DOCUMENTATION, IF ANY 
(COLLECTIVELY, THE “PROGRAM”). THIS EULA CONTAINS IMPORTANT LEGAL LIMITATIONS, RESTRICTIONS AND DISCLAIMERS, AND 
ALSO SPECIFIES THE DURATION OF YOUR LICENSE.
BY INSTALLING THE PROGRAM OR CLICKING ON THE ACCEPTANCE BUTTON OF THE PROGRAM, COPYING OR OTHERWISE USING THE 
PROGRAM, YOU ACKNOWLEDGE AND AGREE THAT YOU HAVE READ THIS EULA, UNDERSTAND IT, AND AGREE TO BE BOUND BY ITS 
TERMS AND CONDITIONS. THIS PROGRAM IS PROTECTED BY COPYRIGHT LAWS AND INTERNATIONAL COPYRIGHT TREATIES, AS WELL 
AS OTHER INTELLECTUAL PROPERTY LAWS AND TREATIES.  YOU MAY USE THE PROGRAM ONLY IN ACCORDANCE WITH THIS EULA, 
AND ANY SUCH USE IS HEREBY UNDERSTOOD TO BE CONDITIONAL UPON YOUR SPECIFIC AGREEMENT TO THE UNMODIFIED TERMS 
SET FORTH HEREIN.  IF YOU DO NOT AGREE WITH ALL OF THE TERMS OF THIS EULA, CLICK ON THE REJECTION BUTTON AND/OR DO 
NOT INSTALL THE PROGRAM AND/OR DO NOT USE THE PROGRAM.  

1. LICENSE
(a)  Under this EULA, you are granted a non-exclusive, non-sublicenseable, non-assignable and non-transferable (except as expressly 

set forth below) license (i) to use and install the Program on a single workstation, and (ii) to make one (1) copy of the Program 
into any machine-readable form for backup of the Program, provided the copy contains all of the original Program’s proprietary 
notices.  

(b)  You may transfer the Program and license to another party only as a part of the RCA branded Portable Digital Audio/Video Device 
(“A/V Device”), and only if the other party agrees to accept the terms and conditions of this EULA.  If you transfer the Program, 
you must at the same time either transfer all copies to the same party or destroy any copies not transferred.

(c)  The terms of this EULA will govern any software upgrades or updates provided by AUDIOVOX that replace and/or supplement the 
original Program, unless such upgrade or update is accompanied by separate license terms and conditions in which case the 
terms of that separate license will govern.  You acknowledge and agree that AUDIOVOX may automatically download upgrades or 
updates to the Program software to your computer in order to update, enhance, and/or further develop the Program.  

2. LICENSE RESTRICTIONS
(a)  Except for the licenses expressly granted to you in this EULA, no other licenses or rights are granted or implied.
(b)  You may not (i) make the Program available over a network where it could be used by multiple computers at the same time; (ii) 

modify, translate, reverse engineer, decompile, disassemble (except to the extent that this restriction is expressly prohibited by 
law), or create derivative works based upon the Program; (iii) copy the Program, except as expressly permitted herein; (iv) remove 
or alter any copyright notices on all copies of the Program; or (v) rent, lease or lend the Program.  You agree that you shall only 
use the Program in a manner that complies with all applicable laws in the jurisdictions in which you use the Program, including, 
but not limited to, applicable restrictions concerning copyright and other intellectual property rights.  

(c)  The Program may contain pre-release code that does not perform at the level of a final code release.  In such case, the Program 
may not operate properly. Updated versions of the Program may be downloaded from www.rcaaudiovideo.com/downloads

(d)  AUDIOVOX is not obligated to provide support services for the Program.
(e)  The Program is provided with “RESTRICTED RIGHTS”. Use, duplication, or disclosure by the U.S. Government is subject to 

restrictions as set forth in subparagraph (c)(1)(ii) of DFARS 252.227-7013, or FAR 52.227-19, or in FAR 52.227-14 Alt. III, as 
applicable.

3. TERM AND TERMINATION
(a)  Your license is effective on the date you accept this EULA and remains in effect until this EULA is terminated by either party.
(b)  You may terminate this EULA and the associated license, without any notice or delay, by destroying or permanently erasing the 

Program and all copies thereof.  
(c)  If you fail to comply with any of the terms of this EULA, in whole or part, your license will automatically terminate without notice 

from AUDIOVOX.
(d)  Upon termination of this EULA and your associated license, you shall cease all use of the Program and destroy or permanently 

erase the Program and all full or partial copies thereof.

4. WARRANTY DISCLAIMER
THE PROGRAM IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE OR NON-INFRINGEMENT. 
THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU.  SHOULD THE PROGRAM PROVE 
DEFECTIVE, YOU (AND NOT AUDIOVOX, ITS SUPPLIERS, OR ITS DEALERS) ASSUME THE ENTIRE COST FOR ALL NECESSARY REPAIR OR 
CORRECTION.
This exclusion of warranty may not be allowed under some applicable laws. As a result, the above exclusion may not apply to you, 
and you may have other rights depending on the law that applies to you.

This is a copy of the EULA that you need to agree to in order to use this product.
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5. OWNERSHIP RIGHTS
All title and intellectual property rights, including but not limited to copyrights, in and to the Program and any copies thereof are 
owned by AUDIOVOX, its Licensors or its suppliers.  All title and intellectual property rights in and to the content which may be 
accessed through use of the Program is the property of the respective content owner and may be protected by applicable copyright 
or other intellectual property laws and treaties. This license grants you no rights to use such content.  All rights not expressly granted 
are reserved by AUDIOVOX or its Licensors. 

6. LIMITATION OF LIABILITY
(a)  TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL AUDIOVOX, OR ITS DEALERS BE LIABLE FOR ANY 

SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES 
FOR LOSS OF PROFITS, BUSINESS INTERRUPTION, CORRUPTION OF FILES, LOSS OF BUSINESS INFORMATION, OR ANY OTHER 
PECUNIARY LOSS) REGARDLESS OF CAUSE OR FORM OF ACTION, INCLUDING CONTRACT, TORT, OR NEGLIGENCE, ARISING OUT OF 
YOUR USE OF OR INABILITY TO USE THE PROGRAM, EVEN IF AUDIOVOX HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES.  BECAUSE SOME STATES AND JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY OF 
CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

(b)  YOU ASSUME RESPONSIBILITY FOR THE SELECTION OF THE APPROPRIATE PROGRAM TO ACHIEVE YOUR INTENDED RESULTS, AND 
FOR THE INSTALLATION, USE, AND RESULTS OBTAINED.

7. WINDOWS MEDIA 
The software embedded within your A/V Device (the “Device Firmware”) contains software licensed from Microsoft that enables you 
to play Windows Media Audio (WMA) files (“WMA Software”).  The WMA Software is licensed to you for use with your A/V Device 
under the following conditions.  By installing and using this version of the Device Firmware, you are agreeing to these conditions.  IF 
YOU DO NOT AGREE TO THE END USER CONDITIONS OF THIS SECTION 7, DO NOT INSTALL OR USE THIS VERSION OF THE DEVICE 
FIRMWARE.

The WMA Software is protected by copyright and other intellectual property laws.  This protection also extends to documentation for 
the WMA Software, whether in written or electronic form.

GRANT OF LICENSE:  The WMA Software is only licensed to you as follows: 
You may use this version of the Device Firmware containing the WMA Software only as such use relates to your A/V Device.

You may not reverse engineer, decompile, or disassemble the WMA Software, except and only to the extent that such activity is 
expressly permitted by applicable law. 
You may transfer your right to use the Device Firmware only as part of a sale or transfer of your A/V Device, on the condition that the 
recipient agrees to the conditions set forth herein.  If the version of the Device Firmware that you are transferring is an upgrade, you 
must also transfer all prior versions of the Device Firmware that you have which include the WMA Software.
MICROSOFT IS NOT PROVIDING ANY WARRANTY OF ANY KIND TO YOU FOR THE WMA SOFTWARE, AND MICROSOFT MAKES NO 
REPRESENTATION CONCERNING THE OPERABILITY OF THE WMA SOFTWARE.

The WMA Software is of U.S. origin.  Any export of this version of the Device Firmware must comply with all applicable international 
and national laws, including the U.S. Export Administration Regulations, that apply to the WMA Software incorporated in the Device 
Firmware.
Content owners use Windows Media digital rights management technology (“WMDRM”) to protect their intellectual property, 
including copyrights.  This device uses WMDRM software to access WMDRM-protected content.  If the WMDRM software fails to 
protect the content, content owners may ask Microsoft to revoke the software’s ability to use WMDRM to play or copy protected 
content.  Revocation does not affect unprotected content.  When you download licenses for protected content, you agree that 
Microsoft may include a revocation list with the licenses.  Content owners may require you to upgrade WMDRM to access their 
content.  If you decline to accept an upgrade, you will not be able to access content that requires the upgrade.

8. THIRD PARTY SOFTWARE
ANY THIRD PARTY SOFTWARE THAT MAY BE PROVIDED WITH THE PROGRAM IS INCLUDED FOR USE AT YOUR OPTION.  IF YOU CHOOSE 
TO USE SUCH THIRD PARTY SOFTWARE, THEN SUCH USE SHALL BE GOVERNED BY SUCH THIRD PARTY’S LICENSE AGREEMENT, AN 
ELECTRONIC COPY OF WHICH WILL BE INSTALLED IN THE APPROPRIATE FOLDER ON YOUR COMPUTER UPON INSTALLATION OF THE 
SOFTWARE.  AUDIOVOX IS NOT RESPONSIBLE FOR ANY THIRD PARTY’S SOFTWARE AND SHALL HAVE NO LIABILITY FOR YOUR USE OF 
THIRD PARTY SOFTWARE.

9. GOVERNING LAW
If you acquired this A/V Device in the United States, this EULA shall be governed and construed in accordance with the laws of the 
State of Indiana, U.S.A. without regard to its conflict of laws principles. If you acquired this A/V Device outside the United States or the 
European Union, then local law may apply.

10. GENERAL TERMS
This EULA can only be modified by a written agreement signed by you and AUDIOVOX, and changes from the terms and conditions 
of this EULA made in any other manner will be of no effect.  If any portion of this EULA shall be held invalid, illegal, or unenforceable, 
the validity, legality, and enforceability of the remainder of the Agreement shall not in any way be affected or impaired thereby.  This 
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Before you begin

Dear RCA Customer, 

Thank you for purchasing the Player.  This product will play mp3 and Windows Media™ audio (WMA) 
content.

RCA easyRip™ Media Software, lets you import music files from CDs and other sources, organize your music 
library, and transfer unprotected MP3 and WMA files to and from this player.

Copyright warning
This player is for your personal use only. Unauthorized recording or duplication of copyrighted material may 
infringe upon the rights of third parties and may be contrary to copyright laws.

Back up your data
As with any portable player, you must back up the drive regularly. The manufacturer is not responsible for 
lost data.

Unpacking your player
All of the items listed below should have been packed in the box with your player.
• RCA player (contains music management software installer and user manual)
• Quick Start Guide
• Earphones
• Detachable carrying clip

Computer system requirements
•  Pentium III 500MHz or higher recommended
• Windows® XP (service pack 1 or higher) or Windows Vista™ or Windows® 7
• Internet access
• Windows Media Player 10 or higher
•  250MB or more free hard disk space for the software
•  128MB RAM (256MB recommended)
• CD drive capable of digital audio extraction
• USB port (2.0 recommended)
• Sound card

Windows, Windows Media, and Windows Vista are trademarks or registered trademarks of Microsoft Corporation in the United States and other 
countries.
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Installing the battery in the player
1. Apply thumb pressure to slide the battery compartment cover in the direction of the arrow, then remove 

the cover.
2. Insert the supplied AAA battery, following the polarity marks in the battery compartment.
3. Replace the cover.
• Refer to the battery level icon  on the display to check the battery level. Replace the battery when the 

icon is empty. 

 

Installing the belt clip

Removing the belt clip

Lift up the 
clip here

Step 2:
Push here 
until the belt 
clip 
completely 
locks in place

Belt clip

Belt clip

Player

Player

Step1:
Place the belt 
clip here



Connecting to the computer

• Rotate the USB plug out of the player body and connect the player to your PC as shown. 
• The player will turn on automatically and display "USB connected" on the display. The player will appear 

as a drive letter on your computer, a Mass Storage Class (MSC) device, and behave as a detachable drive 
for file transfer in one or both directions.

• The RCA easyRipTM Media Software installer is stored on the player. Go to MyComputer in the Start 
menu, fi nd and open the drive letter associated with the player (i.e. RCA MP3) and then double-click 
the rcaeasyrip_setup.exe fi le to launch the installer.  

• The software installer can be deleted from the player after installation to free up more storage space*. 
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• It may take several seconds for the player to be detected. Click View -> Refresh in My 
Computer or Windows Explorer to make sure the player has been detected.

• The player is capable of transferring files at USB 2.0. If a USB 2.0 port is available on your 
computer, use it to connect to your player. The player is still backward compatible with the older USB 
1.1 ports; however, you will not be able to take full advantage of the potential speed increase.

• IMPORTANT: Do not disconnect the USB cable from either the PC or the player during the software 
installation.

* The latest software can be downloaded from www.rcaaudiovideo.com.

Player

USB port of 
your 
computer
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Before you begin using your RCA Player, you’ll want to copy your music to the player. You can use any of the 
following methods to transfer content:

• RCA easyRip
• Drag and drop files using Windows Explorer
• Software provided by online music stores

Using RCA easyRip
easyRip lets you:

• Import music from CDs
• Organize your music library on your PC
• Create playlists
• Copy files from your library to the player
• Copy files from the player to your library
• Delete files from the player

To start easyRip (using either method below):

• Click on the RCA system tray icon and select RCA easyRip from the menu.
• Double-click the easyRip icon on your PC’s desktop. The easyRip dock appears at the side of your screen.

Managing files on your RCA Player

Help – For detailed explanation on using easyRip, click the Help module on the 
Module Dock.  

Using Windows Explorer 
To copy files in Windows XP , Windows Vista or Windows® 7:

1. Open the player in Windows Explorer.

2. Drag and drop music files onto the drive letter associated with the player.
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Deleting files from the player
You may delete any files transferred to the player.
1. Connect the player to your computer.

2. Open the player in Windows Explorer and then navigate to the folder containing the files.

3. Select the files you want to remove and then press the Delete key on the keyboard of your PC.

Disconnecting the player from the PC
Windows will show the player as a removable disk:

1. In the Windows system tray, click the Safely Remove Hardware icon  and then select the device with 
the appropriate drive letter from the list of devices. 

2. When the Safe to remove hardware message appears, unplug the player from the PC.

 

IMPORTANT:  Do not disconnect the USB connection during file transfer. Doing so may 
corrupt system files or the files being transferred.
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General controls

Turning the player on and off
Turn player on/off: Slide and hold the Power/Lock Slider ( / ) away from the headphone jack. 

Locking the player controls
Lock player controls: Slide the Power/Lock Slider ( / ) toward the headphone jack. 

• When the controls are locked, the message "Keys Locked" appears on the display.

Unlock player controls: Slide the Power/Lock Slider ( / ) toward the middle position.

Resetting the player
If the player stops operating properly, you can reset it by removing and re-installing the battery.

Earphone socket

Power on/off, 
lock/unlock 
player 
controls

USB 
plug

Display

Play/pause/
select menu 

option

Scroll up/increase volume

Scroll down/decrease volumeSkip back/
reverse/menu 

back

Skip forward/
fast forward/

menu advance

Option menu

Back/Home
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Using the menus

Menu types
The player has two menu types: 

Player menu

The player menu appears when you turn on the player or if you press and hold  while listening to the 
player. It lets you:

• Select music and audiobook files
• Change the player’s settings

Option menu

The option menu appears if you press  at the playback (Now Playing) screen while listening to the player. 
It provides different options depending on what you are listening to when you press  .

Menu navigation
When a menu is displayed:

• Press + and – to scroll up and down the list of menu items. 
• Press   or  to go to the next menu level. Press  to return to the previous menu level.

• If the highlighted item is playable (for example, an audio file), press  or  to start playback.

• If the highlighted item indicates the current setting (for example, the repeat mode setting), press  to 
change the setting.

Menu title Menu items

Press +Press +Press +

Press –Press –Press –

Play All Songs
Artists
Albums

Press  
or 

Press  
or 

Press  
or 

Press Press Press 

Play All Songs
Title 1
Title 2

Play All Albums
Album 1
Album 2

Artist 1
Artist 2
Artist 3

Shuffle                     Off

Equalizer                Flat
Repeat              Off

Shuffle                     On

Equalizer                Flat
Repeat              OffRepeat                    Off Repeat                    All

Add to Favorites Add to FavoritesPress  

Title1
Title2
Title3

All My Friends
Artists1

0001/0030         2:30

Press  
or 

All My Friends
Artists1

0001/0030         2:30

"Now Playing" 
screen

Option menu

Press 
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The Home menu
The top-level or “Home” menu is always displayed when you press and hold  . The menu options are:

Now Playing

Available only during playback. 
Press  or  to return to the currently playing file.

Music

Press  or  to enter the Music menu and choose an artist, album or genre.

Audiobooks

Press  or  to enter the Audiobook menu and choose a particular audiobook for listening.

Favorites

As you listen to music, you can add individual titles to a “favorites” playlist. Press  or  to enter the 
Favorites menu and choose a particular title or edit the playlist.

Settings

Press  or  to enter the Settings menu, which lets you:
• Choose the shuffle playback mode
• Choose a repeat playback mode
• Choose an equalizer setting
• Change the screen contrast
• Choose the screensaver setting
• Choose the power saving setting
• Change the language of the player’s menus
• Perform sorting to all music files. 
• Display the firmware version, space available and total space
• Reset the player’s settings to the factory defaults
• Format device to cleanup all data and old license file
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Music

Music playback controls

Skips to the previous file*; press and 
hold to scan backward

Skips to the next file, press and hold to 
scan forward

Starts/pauses playback

Shows/ hides the Option menu

Increases or decreases the volume 
during playback

  

 

 

+ or –

Playing music files
The player sorts your music files by artist, album and genre.

1. Press and hold  to display the Home menu, then press + or – to select Music.

 
2. Press  or  to enter the Music menu. 
3. Use + or – and  or  to navigate through the menus and select the desired item, then press  or  to 

start listening.

* Press  within the beginning 4 seconds of the 
current music file to skip to previous file. Otherwise, 
you will return to the beginning of the current file.

Option menu (music playback)

Press  at the playback (Now Playing) screen to show the Option menu. Press + or – to highlight an option 
and then press  to confirm the selection or change the setting.

The following options are available: 
• Add to Favorites – Adds the current file to the Favorites playlist (see page 21). Each file can be added to 

the Favorites playlist multiple times.
• Repeat – Toggles repeat mode. Options available: Off, One  , and All  (corresponding icons show on 

the display).
•  Shuffle – Toggles shuffle mode. Plays media randomly when shuffle is On.
•  Equalizer – Toggles equalizer mode. Options available: Flat, Bass, Pop, Rock and Jazz.
•  Delete – Deletes the currently playing media file from the player.
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Option menu (navigating music files)

Press  when navigating through music files to show the Option menu. Press + or – to highlight an option 
and then press  to confirm the selection or change the setting.

The following options are available: 
• Now Playing – Returns  to the Now Playing screen during playback
• Delete – Deletes the selected song
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Audiobooks

Audiobook playback controls

Skips to previous file or section; press 
and hold to scan backward within a file

Skips to the next file or section; press 
and hold to scan forward within a file

Starts/pauses playback

Shows/ hides the Option menu

Increases or decreases the volume 
during playback

  

 

 

+ or –

Option menu (Audiobook playback)

Press  at the playback (Now Playing) screen to show the Option menu. Press + or – to highlight an option 
and then press  to confirm the selection or change the setting.

The following options are available:
• Skip – Skips by section or by file. (Refer to below section for details)
• Delete – Removes current file from the player.

 

Playing audiobooks
Audiobook playback is similar to music playback.

1. Press and hold  to display the Home menu, then press + or – to select Audiobooks.

 
2. Press  or  to enter the Audiobooks menu. 
3. Use + or – and  or  to navigate through the menus and select the desired item, then press  or  to 

start listening.
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Skipping through audiobook sections
If the currently playing audiobook contains sections, you can choose to skip forward and back between 
sections when you press  or  , instead of skipping between files.

To choose section-by-section skipping:

1. Press   to display the Option menu.

2. Press + or – to select Skip, then press  to switch to Section.

 
3. Press  or  to resume playback.

 
• The player returns to file-by-file skipping automatically when you play another file or turn the player off.



21

Favorites

Creating a "Favorites" playlist
You can create a playlist of your favorite music by adding new files to the playlist as you listen to them.
This function is not available for other media formats such as audiobooks and recordings.

To add the currently playing music file in the playlist:

1. Press  to display the Option menu.

2. Press + or – to highlight Add to Favorites and then press  . 

 
• Repeat the above steps for adding more music files. 

To listen to the Favorites playlist:

1. Press and hold  to display the Home menu. 

2. Press + or – to select Favorites and press  or  to enter.

 

3. To play back a particular file, press  or  to list the files. Press + or – to select the desired file and press 
 or .

 

MySelections               >

Removing files from "Favorites" playlist
To remove a music file from the playlist:

1. Play the selected file from Favorites playlist.

2. Press  to display the Option menu. Now "Clear from Favorites" is highlighted.

 

Clear from Favorites

3. Press  to remove this file from the playlist.

Downloading playlists to player
You can also download playlists of your favorite music created on the RCA easyRip software. Please refer to 
the Help module in easyRip for details on creating playlists and transferring the created playlists to the 
player.
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Changing the player’s settings
To change the player settings:

1. Press and hold  to display the Home menu.

2. Press + or – to select Settings and press  or  to enter the settings menu.

 

3. Press + or – to select a setting and then press   to change it.

 

Shuffle 
• Plays back music tracks (mp3/wma/wav) in a random order.

• Options: On (Display indicator:   ) and Off.

Repeat
• Repeats music tracks based on selected mode. When repeat mode One is selected, the current track will 

repeat. When repeat mode All is selected, all files in the current album will repeat.
• Options: One (Display indicator: ), All (Display indicator:   ), and Off.

Equalizer
• Switches current equalizer mode used to play back music tracks. Each mode corresponds to different 

types of music to enhance your listening experience.
• Options: Flat, Bass, Pop, Rock and Jazz.

Contrast 
• Adjusts the display contrast. 

Screensaver
•  Sets the screensaver activation time which will launch the screensaver after specified duration of 

inactivity.
•  Options: 10 sec., 20 sec., 30 sec., or 1 min.

PowerSave 
•  Sets the powersave interval time which will turn the player off after specified duration if no key is 

pressed.
•  Options: Off, 1 min., 2 min., 5 min., 10 min.

Language 
•  Changes the language of the player menus.

•  Options: English, Français, Español

Profiling
• Performs sorting to all music files. "Profiling..." will be displayed until the sorting finishes.

Settings
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System Info
• Displays the amount of free space available and the firmware version.

Restore defaults
•  Resets all menus to factory defaults.

Format device
•  Format device will cleanup all data and old license file. Make sure to backup your data before formatting 

device.
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Additional information

Tips and troubleshooting
Cannot delete files on the player.

•  You can delete files on the player using your computer.
1.  Connect the player to your computer.
2.  Open the player in Windows Explorer and navigate to the folder containing the files.
3.  Select the files you want to remove and then press the Delete key on the keyboard of your PC.

 • For deleting files from the player, refer to Option menu from page 17-22 for details.

Player repeats same tracks or all tracks.

• Repeat play is turned on. Press  during playback to show the Option menu and select Repeat Off. You 
can also press   to return to Home menu. Then press + or – to select Settings and press  to enter the 
settings menu to select Repeat Off.

Audio distorted at high volume.

• Change the Equalizer mode to Flat.
• Turn down the volume.

The audio tracks on my player keep skipping or popping.

• You’ll need to rip the audio track again– make sure you close all other applications on your PC when you 
record.

• Try recording with Error Correction setting turned on.

Player turns itself off.

• Your player turns itself off if you leave it in pause mode or navigation mode for the duration specified in 
PowerSave setting.

The player cannot be turned on.
• Battery is empty.
• Ensure the Power/Lock Slider is not in the Lock position.
• Reset the player by removing and re-installing the battery.

• If the player will not turn on after resetting, perform a firmware upgrade to restore it.
• Please go to www.rcaaudiovideo.com for more helpful troubleshooting tips.
• To resume normal operation, it may be necessary to cycle the power off and back on or perform a reset 

by removing and re-installing the battery.

Player does not respond to key presses.

•  If your player stops responding to key presses, you can reset it by removing and re-installing the battery. 
Most of your settings will be preserved; only the settings that you have changed after your last power off 
will be lost.

• This player may temporarily cease to function if subjected to electrostatic disturbance. To resume normal 
operation, it may be necessary to cycle the power off and back on or by removing and re-installing the 
battery. 

• Make sure the Lock function is not activated.

Player cannot play WMA songs.

• Secure music is not supported by this player.

Player cannot play AAC songs.

• Visit www.rcaaudiovideo.com to download the latest firmware for the player to support the playback of 
AAC songs.
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The player takes a long time to read files in a folder.

• File reading may take longer if too many files are put in a single folder. Re-organize your files into a 
number of folders. 

Song information is not showing correctly.

• Song information may not match your current player’s language setting. Change the language setting.  

The player reports that it is full.

• You have filled the capacity of the internal memory of the player.

Cannot playback tracks on the player.

•  Make sure audio tracks are encoded in the mp3 or Windows Media formats at supported bitrates.
• Bitrates support by the player:
 mp3 – 32 to 320 kbps
 wma – 48 to 192 kbps
•  WMA files may be DRM protected and this player does not support playback of protected files.

Cannot find tracks which copied to the player.

•  Perform a profiling to sort all music files in the player (Home => Settings => Profiling).

Cannot play Audible files.

• Make sure the file format is correct. The player only supports .AAX Audible files. Audible files must be 
transferred to the Audible folder in the player for proper playback.

How to format device?

• Perform a format to clean up all data in device (Home => Settings => Format Device). Make sure to 
backup your data before formatting device.

For your records 
Keep your sales receipt for proof of purchase to obtain warranty parts and service.
In the event that service should be required, you may need both the model number and the serial number.  
In the space below, record the date and place of purchase, and the serial number: 
Model No.
Date of Purchase 
Place of Purchase 
Serial No.  

Visiting RCA website
Please visit www.rcaaudiovideo.com for:
• Product registration
• Latest software and firmware
• Latest RCA easyRip software
• User manual
• Frequently asked questions (FAQ)
• Customer service and technical support information
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Specifications
Technical specification

Product: Digital Audio Player
Brand: RCA
Model: TH2202, TH2202R, TH2204, TH2204R, TH2002, TH2002R, TH2004, TH2004R and TH2002RDR

Hardware

• Dimensions: 18.30 mm x 78.70 mm x 37.10 mm
• Unit Weight: 24 g without 3A battery
• Stereo Headphones jack
• USB Connection Jack

USB Drive

• External USB Drive: When connected to a computer via USB, the player is capable of storing any file type 
allowing the user a fast, convenient method of storing, retrieving, and transferring files. This includes 
word processing files, presentations, spreadsheets and any other computer files.

• Capacity: 2GB (TH2202, TH2202R, TH2002, TH2002R and TH2002RDR), 4GB (TH2204, TH2204R, TH2004 
and TH2004R)

Software

• Includes the player applications and media management software.
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Warranty information

Limited warranty
12 Month Limited Warranty

Applies to RCA Audio/Video Products

AUDIOVOX ELECTRONICS CORP. (the Company) warrants to the original retail purchaser of this product that 
should this product or any part thereof, under normal use and conditions, be proven defective in material or 
workmanship within 12 months from the date of original purchase, such defect(s) will be repaired or 
replaced with reconditioned product (at the Company's option) without charge for parts and repair labor.

To obtain repair or replacement within the terms of this Warranty, the product is to be delivered with proof 
of warranty coverage (e.g. dated bill of sale), specification of defect(s), transportation prepaid, to the 
Company at the address shown below.

This Warranty does not extend to the elimination of externally generated static or noise, to correction of 
antenna problems, loss/interruptions of broadcast or internet service, to costs incurred for installation, 
removal or reinstallation of product, to corruptions caused by computer viruses, spyware or other malware, 
to loss of media, files, data or content, or to damage to tapes, discs, removable memory devices or cards, 
speakers, accessories, computers, computer peripherals, other media players, home networks or vehicle 
electrical systems.

This Warranty does not apply to any product or part thereof which, in the opinion of the Company, has 
suffered or been damaged through alteration, improper installation, mishandling, misuse, neglect, accident, 
or by removal or defacement of the factory serial number/bar code label(s). THE EXTENT OF THE COMPANY'S 
LIABILITY UNDER THIS WARRANTY IS LIMITED TO THE REPAIR OR REPLACEMENT PROVIDED ABOVE AND, IN 
NO EVENT, SHALL THE COMPANY'S LIABILITY EXCEED THE PURCHASE PRICE PAID BY PURCHASER FOR THE 
PRODUCT.

This Warranty is in lieu of all other express warranties or liabilities. ANY IMPLIED WARRANTIES, INCLUDING 
ANY IMPLIED WARRANTY OF MERCHANTABILITY, SHALL BE LIMITED TO THE DURATION OF THIS WRITTEN 
WARRANTY. ANY ACTION FOR BREACH OF ANY WARRANTY HEREUNDER INCLUDING ANY IMPLIED 
WARRANTY OF MERCHANTABILITY MUST BE BROUGHT WITHIN A PERIOD OF 24 MONTHS FROM DATE OF 
ORIGINAL PURCHASE. IN NO CASE SHALL THE COMPANY BE LIABLE FOR ANY CONSEQUENTIAL OR 
INCIDENTAL DAMAGES FOR BREACH OF THIS OR ANY OTHER WARRANTY. No person or representative is 
authorized to assume for the Company any liability other than expressed herein in connection with the sale 
of this product.

Some states do not allow limitations on how long an implied warranty lasts or the exclusion or limitation of 
incidental or consequential damage so the above limitations or exclusions may not apply to you. This 
Warranty gives you specific legal rights and you may also have other rights which vary from state to state.
 
How to make a warranty claim:

• If your product is capable of storing content (such as an mp3 player, digital voice recorder, etc), it is 
recommended to make periodic backup copies of content stored on the product. If applicable, before 
shipping a product, make a back up copy of content or data stored on the device. Also, it is advisable to 
remove any personal content which you would not want exposed to others. IT IS LIKELY THAT CONTENTS 
AND DATA ON THE DEVICE WILL BE LOST DURING SERVICE AND REFORMATTING. AUDIOVOX ACCEPTS NO 
LIABILITY FOR LOST CONTENT OR DATA, OR FOR THE SECURITY OF ANY PERSONAL CONTENT OR DATA 
ON THE RETURNED DEVICE. Product will be returned with factory default settings, and without any pre-
loaded content which may have been installed in the originally purchased products.  Consumer will be 
responsible for reloading data and content. Consumer will be responsible to restore any personal 
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preference settings. 
• Properly pack your unit. Include any remotes, memory cards, cables, etc. which were originally provided 

with the product. However DO NOT return any removable batteries, even if batteries were included with 
the original purchase. We recommend using the original carton and packing materials.

• Include evidence of purchase date such as the bill of sale. Also print your name and address and a 
description of the defect. Send via standard UPS or its equivalent to:

 Audiovox Electronics Corp.

 Attn: Service Department.

 150 Marcus Blvd.  

 Hauppauge N.Y. 11788

 1-800-878-5779
     
•  Insure your shipment for loss or damage. Audiovox accepts no liability in case of damage or loss en route 

to Audiovox.
•  Pay any charges billed to you by the Exchange Center for service not covered by the warranty.
•  A new or refurbished unit will be shipped to you freight prepaid.

What we will do:

Provide you with a new, or at our option, a refurbished unit. The exchange unit is under warranty for the 
remainder of the original product’s warranty period. 

For Canada Customers, please ship to:

Audiovox Return Centre
c/o Genco
6685 Kennedy Road,
Unit#3, Door 16,
Mississuaga, Ontario
L5T 3A5



© 2010 Audiovox Accessories Corporation
111 Congressional Blvd., Suite 350
Carmel, IN 46032
Trademark(s) ® Registered

v5.0 (1.0.5.0) 

Illustrations contained within this publication are for representation only and subject to change.

The descriptions and characteristics given in this document are given as a general indication and not as a 
guarantee.  In order to provide the highest quality product possible, we reserve the right to make any 
improvement or modification without prior notice.  

Visit http://store.audiovox.com to find the 
best accessories for your products.
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